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Introduction

Introduction
Thank you for purchasing the Canon S520 Bubble Jet Printer. This User’s Guide provides 
complete explanations of the features and functions of the printer. 

This guide uses the following symbols to indicate important information. Always observe 
these instructions.

Warning ➤ Instructions that, if ignored, could result in death or serious personal injury 
caused by incorrect operation of the equipment.
These must be observed for safe operation.

Caution ➤ Instructions that, if ignored, could result in personal injury or material 
damage caused by incorrect operation of the equipment. 
These must be observed for safe operation.

Important ➤ Prohibited actions that, inadvertently performed, could result in equipment 
damage, faults or impaired product quality.
These must be avoided for correct operation.

Information for Windows users only.

Information for Macintosh (USB users only).

Windows

Macintosh
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How to Use This Manual

How to Use This Manual
To view this User’s Guide, we recommend that you use Acrobat Reader 3.0 or later. The 
screens shown below are for Acrobat Reader 4.0. Please note that screens displayed by 
Acrobat Reader 3.0 or 5.0 are slightly different.

Use this button to enlarge the 
viewing screen. Click this button in 
the tool bar, then click within the 
screen. Displays the next page.

Returns to the page 
you were previously 
viewing.

Click to jump straight to this 
page.

Displays the previous page.
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How to Use This Manual

Displays the table of contents. 
Click the heading to jump to the topic.
Click the " " symbol to see the headings for each chapter.
Click the " " symbol to close the headings.

Use this button to 
search for a word.
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Safety Precautions

Safety Precautions
Please read the safety warnings and cautions provided in this manual to ensure that you 
use the printer safely. Do not attempt to use the printer in any way not described in this 
manual.

Warning ➤ You may cause an electric shock/fire or damage the printer if you ignore 
any of these safety precautions.

■ Choosing a location

Do not place the printer close to flammable solvents such as alcohol or thinners.

■ Power supply

Never attempt to plug in or unplug the printer from the power supply when your hands 
are wet.

Always push the plug all the way into the power outlet.

Never damage, modify, stretch or excessively bend or twist the 
power cord. Do not place heavy objects on the power cord.
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Safety Precautions

Never plug the printer into a power socket that is shared with other 
equipment (extension lead, double adapter, etc.).

Never use the printer if the power cord is bundled or knotted.

If you detect smoke, unusual smells or strange noises around the printer, immediately 
unplug the printer at the power supply and call for service.

Periodically, unplug the printer and use a dry cloth to wipe off any 
dust or dirt that has collected on the plug and the power outlet. If the 
printer is placed at a location exposed to a lot of dust, smoke or high 
humidity, it may absorb moisture and cause insulation failure and fire.

■ Cleaning the printer

Use a damp cloth to clean the printer. Never use flammable solvents 
such as alcohol, benzene or thinners.

If flammable solvents come in contact with electrical components inside the printer, 
it could cause a fire or electric shock.

Always unplug the printer from the power outlet before cleaning the printer.

If you accidentally switch the printer on while cleaning it, you could injure yourself or damage the printer.
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Safety Precautions

■ Maintaining the printer

Do not attempt to disassemble or modify the printer. There are no user-serviceable parts 
inside the printer.

The printer contains high-voltage components. Never attempt any maintenance procedure not described in 
this guide.

■ Working around the printer

Do not use flammable sprays near the printer.

This could cause a fire or electric shock if the spray comes into contact with electrical components inside 
the printer.

Never put your hands or fingers in the printer while it is printing.

Do not place metal objects (paper clips, staples, etc.) or containers of flammable 
solvents (alcohol, thinners, etc.) on top of the printer.

If any foreign object (metal or liquid) falls into the printer, unplug the power cord and call 
for service.

Caution ➤ You may cause injury or damage the printer if you ignore any of these 
safety precautions.
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Safety Precautions

■ Choosing a location

Do not install the printer in a location that is unstable or subject to excessive vibration.

Do not install the printer in a location that is very humid or dusty, in direct sunlight, 
outdoors, or close to a heating source.

To avoid the risk of fire or electric shock, install the printer in a location with an ambient temperature range 
of 41°F to 95°F (5°C to 35°C) and humidity of 10% to 90% (condensation free).

Do not place the printer on a thick rug or carpet.

Ensure that the area around the power outlet is kept clear at all times 
so you can easily unplug the power cord if necessary.

When moving the printer, hold it at both ends.

■ Power supply

Never remove the plug by pulling on the cord.
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Safety Precautions

Do not use an extension cord.

If you do not intend to use the printer for a long period of time, unplug 
it after turning it off.

Never use a power supply voltage other than that supplied in the 
country of purchase.

The correct power supply voltages and frequencies are as follows:
USA/Canada: AC 120V, 60Hz
Europe: AC 230V±10%, 50Hz
Australia: AC 240V, 50Hz

■ Printheads and ink tanks

For safety reasons, store printheads and ink tanks out of the reach of small children.

If a child ingests any ink, consult a doctor immediately.

Do not shake printheads or ink tanks.

Ink may leak out and stain clothing or the surrounding area.

Never touch the electrical contacts on a printhead after printing.

The metal parts may be very hot and could cause burns.
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Printer Parts and Their Functions

Printer Parts and Their Functions

• Front View

• Rear View

• Inside the Printer

• Operation Panel
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Printer Parts and Their Functions

Front View

Paper guide
When loading paper, 
ensure that the left edge 
touches this guide.
To move the paper guide, 
pinch the guide and slide in 
the appropriate direction.

Paper rest

Sheet feeder
Load paper here. 
Paper feeds 
automatically, one 
sheet at a time.

Front cover
Open to replace the 
ink tanks or remove 
jammed paper.

Paper output tray

Operation panel
For details, refer to 
"Operation Panel." 
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Printer Parts and Their Functions

Rear View

USB port
Connects the printer to a 
computer through a USB port.

Printer port (parallel)
Connects the printer to a 
computer through a parallel port.
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Printer Parts and Their Functions

Inside the Printer

Printhead holder
Install the printhead here.

Printhead lock lever
Locks the printhead into the holder. 
Once the printhead is installed, do not touch this lever.

Paper thickness lever
Adjusts the gap between the printhead and the surface of the printing paper.
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Printer Parts and Their Functions

Operation Panel

POWER lamp
Off: The printer is turned off.
Green: The printer is ready to print.
Flashing green: The printer is preparing to print, or is currently printing.
Flashing orange: An error has occurred and the printer is not ready to print.
Flashing orange and green alternately: an error has occurred that may require you to 
contact a Customer Care Representative.

POWER button
Press to turn the printer 
on or off. The printer will 
initialize, then be ready 
for printing.

RESUME/CANCEL button
Press to resume printing once an error has 
been cleared. To cancel printing in 
progress, press this button.
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Printer Driver Functions (Windows)

 Printer Driver Functions (Windows)

• Opening the Printer Properties Dialog Box

• Printer Properties Dialog Box Description

• BJ Status Monitor Functions

• Canceling a Print Job

• Uninstalling Printer Drivers
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Printer Driver Functions (Windows)

Opening the Printer Properties Dialog Box

The Printer Properties dialog box can be opened from either within an application, or 
directly from the Windows Start menu.

■ Opening the Printer Properties dialog box from your application program

This method is generally used to specify printer settings just before printing. The 
operations may vary slightly depending upon your application program. This section 
describes only the general procedure for opening the Printer Properties dialog box. 

1 In your application, select the command to print a document.

The Print dialog box can usually be opened by selecting Print from the File 
menu.

2 Ensure that Canon S520 is selected in the Name field, then click the 
Properties button.

The Printer Properties dialog box opens. 

Note ➤ Depending upon your application program, the command and menu names 
may differ, and there may be more steps involved in opening the Printer 
Properties dialog box. For further details, see the user's manual for your 
application. 
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Printer Driver Functions (Windows)

■ Opening the Printer Properties dialog box directly from the Start menu

This method is used for maintenance operations such as printhead cleaning, or to 
specify printer settings common to all application programs.
When the Printer Properties dialog box is opened from the Start menu, additional tabs 
appear, including the Details tab. These do not appear when the Printer Properties 
dialog box is opened from within an application. 
For further information about these additional tabs, refer to your Windows 
documentation.

1 Click the Start button, then click Settings, then Printers.

For Windows XP, click Start, then click Control Panel, Printers and Other 
Hardware, then Printers and Faxes.

2 Click the Canon S520 icon.

3 Open the File menu and click:
• Windows Me/Windows 98/Windows 95 ➔  Properties
• Windows NT 4.0 ➔  Document Defaults
• Windows XP/Windows 2000 ➔  Printing Preferences

The Printer Properties dialog box opens. 
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Printer Driver Functions (Windows)

Printer Properties Dialog Box Description

Note ➤ The screens in this section refer to Windows Me/Windows 98/Windows 95 
operation. The equivalent screens for Windows XP, Windows 2000 and 
Windows NT 4.0 may look slightly different.

• Main Tab
• Page Setup Tab
• Stamp/Background 

Tab (Not Available in 
Windows NT 4.0)

• Effects Tab
• Profiles Tab

• Maintenance Tab
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Printer Driver Functions (Windows)

Main Tab

(1) Media Type
Ensure that this setting matches the type of media loaded in the printer. 

(2) Print Quality
Select the print quality you require from among the different options. To select custom 
Print Quality, select Custom, then click the Set button. 

(6)

(5)

(4)

(1)

(2)

(3)
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Printer Driver Functions (Windows)

(3) Color Adjustment 
Select the method of color adjustment. To make detailed color adjustments, select 
Manual, then click the Set button. 

(4) Grayscale Printing
Select to print a grayscale version of a color document. 

(5) Print Advisor
Click to start the Print Advisor. 
The Print Advisor simplifies configuration of the printer driver. By having the user 
answer a series of questions, the Print Advisor automatically configures the printer 
driver settings.

(6) Preview Area
Before printing, verify that settings such as the lever position are correct.

Note ➤ To see a description of any item in the Printer Properties dialog box, click 
the  mark, then click the desired item. To see a description of operating 
procedures, click the Help button. If the button does not appear when using 
Windows XP, Windows 2000 or Windows NT 4.0, click the Start button, 
then select Programs, then Canon S520, then Guide.
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Printer Driver Functions (Windows)

Page Setup Tab

(1) Page Size
Ensure that the correct paper size is selected.

(2) Orientation
Select landscape or portrait printing and ensure that it is the same orientation used in 
the application. 

(9)

(2)

(1)

(3)

(5)
(6)

(4)

(7)

(8)
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Printer Driver Functions (Windows)

(3) Printing Type
Select the printing method from among the following.

Normal-size Printing The document is printed according to the original 
dimensions. This setting is usually selected by default. 

Fit-to-Page Printing The document is automatically resized to fit the paper size. 
When using this function, ensure that you correctly specify 
the Page Size and the Printer Paper Size. 

Scaled Printing The document is resized when printed. When this is 
selected, you can specify the Printer Paper Size and 
Scaling.

Page Layout Printing Pages are reduced and printed so that 2 to 16 document 
pages fit on each printed page.

Booklet Printing The multi-page document is printed so that two pages of the 
document fit on each printed page. The print order is set 
automatically. After the document is printed, you can create 
a booklet by folding and saddle-stitching the document.

Poster Printing This enlarges and splits the print image across several 
sheets of paper. The printed sheets can then be assembled 
to make a large poster. (Not available in Windows NT 4.0)

Banner Printing Select this when printing on banner paper.

(4) Borderless Printing
The image is printed on the entire paper surface so that no margins are left on the four 
sides of the paper. The media types available for Borderless Printing are PR-101 and 
GP-301/GP-301N. For all other media types, the print quality may decrease.

(5) Amount of Extension
When you select Borderless Printing, the sections that extend beyond the paper are 
not printed because the image is enlarged to a size slightly larger than the paper size. 
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Printer Driver Functions (Windows)

You can use the slider to adjust how much the image extends beyond the paper. It is 
recommended that you normally set the slider to the right end. If you move the slider 
to the left to reduce the extension amount, a border may appear.

(6) Duplex Printing
The document is printed on both sides of the paper. After printing one side, turn the 
ejected page over and print on the other side.

(7) Reverse Order
Prints the document starting with the last page. 

(8) Collate
Select to print multiple copies of the document one copy at a time.

(9) Preview Area
Verify the overall layout, stamps, background and other settings to be applied to the 
print job. 
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Printer Driver Functions (Windows)

Stamp/Background Tab (Not Available in Windows NT 
4.0)

(1) Stamp
Select the check box, then choose a stamp. 

(2) Place stamp over text
When Stamp is checked, this option is active. When selected, the stamp is printed 
over the print data.

(1)

(2)
(3)

(4)

(5)

(6)
(7)(8)



Printer Properties Dialog Box Description 27

Printer Driver Functions (Windows)

(3) Stamp first page only
Prints the stamp only on the first page. 

(4) Define Stamp
This lets you create new stamps, or modify details of a selected stamp. 

(5) Background
Select the check box, then choose the background image you wish to use. 

(6) Background first page only
Prints the background image only on the first page. 

(7) Select Background
Click to select a new background, or to display details of the background you have 
selected. 

(8) Preview Area
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Printer Driver Functions (Windows)

Effects Tab

(1) Simulate Illustration
This function lets you apply graphic effects to a color image without affecting the 
original document. Select the check box, then adjust the brightness of the image with 
the Contrast slider.

(6)

(1)

(2)

(5)

(3)

(4)
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Printer Driver Functions (Windows)

(2) Monochrome Effects
Prints a color image in a single color. Select the check box, then choose a color or use 
a custom color using Select Color.

(3) Vivid Photo
By using this function, you can reproduce breathtaking sceneries in which colors, 
especially blues and greens, appear even more vibrant. A major feature of this 
function is its ability to create vivid backgrounds for fields, trees, oceans, and sky, 
while maintaining the natural skin tones of people who appear in the images.

(4) Image Optimizer
Improves the contours and jaggedness that occur when photographic or graphic 
image data is enlarged within an application.

(5) Photo Optimizer PRO
Optimizes the color for images taken from a digital camera or scanner. It is especially 
effective for images affected by color imbalance and over or under exposure.
When printing several images on one page, optimization is usually applied to each 
image according to its requirements. However, if the image data has been 
manipulated using cut and paste, rotation or other such operations, group optimization 
of all images on the page is recommended. In such cases, select the Apply 
Throughout Page check box. 

(6) Preview Area
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Printer Driver Functions (Windows)

Profiles Tab

(1) Printing Profiles
This list displays the print settings currently registered in the Profiles tab.
The Current Settings profile contains the settings currently specified on the Main, 
Page Setup and Effects tabs. The Default Settings profile contains the factory 
default settings.

(1)

(4)

(2)

(3)

(6)

(5)
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Printer Driver Functions (Windows)

(2) Details
Displays all the printer settings selected in Printing Profiles.

(3) Description
Displays a description of the printer settings selected in Printing Profiles. You can 
enter the description when saving the printer settings. 

(4) Add to Profiles
Click to save the settings currently specified on the Main, Page Setup and Effects 
tabs. Select Current Settings in the Printing Profiles list, then click this button. The 
Add to Profiles dialog box appears.

(5) Retrieve from Profiles
Click to activate registered printer settings. The contents of the Main, Page Setup and 
Effects tabs are changed by selecting the printer settings in Printing Profiles, then 
clicking this button. This button is disabled when Current Settings is selected.

(6) Delete
Click to delete unwanted printer settings. Select the unwanted item in the Printing 
Profiles list, then click Delete. Current Settings and Default Settings cannot be 
deleted.



Printer Properties Dialog Box Description 32

Printer Driver Functions (Windows)

Maintenance Tab

(1) Cleaning
Click to start printhead cleaning.

(2) Deep Cleaning
Click to start printhead deep cleaning.
Use this function only if Cleaning has not improved print quality.

(1)

(2)

(4)

(5)

(7)

(8)

(6)(3)
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Printer Driver Functions (Windows)

(3) Printhead Alignment
Click to start the printhead alignment procedure. For details on printhead alignment, 
refer to the printed Quick Start Guide.

(4) Nozzle Check
Click to start a nozzle check pattern. The nozzle check pattern ensures that the 
printhead nozzles are ejecting ink properly. For details, refer to “Examining the Nozzle 
Check Pattern.”

(5) Power Off
Click to turn the printer off.

(6) Auto Power
Click to enable the printer to turn off automatically when no data is sent to the printer 
for a certain period of time, and to automatically turn the printer on again when data is 
sent to the printer.

(7) Custom Settings
Click to modify the printer mode. Change the settings in the Custom Settings dialog 
box, then click Send to change printer mode.

(8) Start Status Monitor
Click to start the BJ Status Monitor, which checks and reports the printer status and 
the progress of printing jobs. 
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Printer Driver Functions (Windows)

BJ Status Monitor Functions

The BJ Status Monitor displays the status of the printer. If an error occurs, the status 
monitor indicates the nature of the error and suggests an appropriate solution. The status 
monitor also checks the ink tanks and displays a warning message when the ink is low.

■ Launching the BJ Status Monitor

The BJ Status Monitor launches automatically when data is sent to the printer. When 
launched, the BJ Status Monitor appears as an icon on the taskbar. 

1 Click the Canon BJ Status Monitor icon on the taskbar.

The BJ Status Monitor appears.
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Printer Driver Functions (Windows)

Note ➤ To open the BJ Status Monitor when the printer is not printing, click the 
Maintenance tab in the Printer Properties dialog box, then click Start 
Status Monitor.
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Printer Driver Functions (Windows)

■ When errors occur or ink runs low

The BJ Status Monitor is automatically displayed when an error occurs, such as if the 
printer runs out of paper or ink is low. In such cases, take the action described in the 
Printer Status tab.
In Windows 95, Windows 98 or Windows Me, click the Guide tab and follow the 
instructions on the screen.

Note ➤ For details on the BJ Status Monitor, click the Help menu, then click the 
topic of interest.

When paper has run out: When the ink level is low:
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Printer Driver Functions (Windows)

Canceling a Print Job

To cancel the current print job, first open the BJ Status Monitor. 

1 Click the Canon BJ Status Monitor icon on the taskbar.

2 Click Cancel Printing.

Note ➤ If Cancel Printing is grayed out, press the RESUME/CANCEL button on 
the printer to terminate the print job. 
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Printer Driver Functions (Windows)

Uninstalling Printer Drivers

Use the Uninstaller to delete any unwanted printer drivers. This allows you to delete all files 
associated with the printer driver at the same time.

1 Click the Start button, then click Programs, then Canon S520, then 
Uninstall.

For Windows XP, click the Start button, then select All Programs, then 
Canon S520, then Uninstall.

2 Click Yes when the confirmation message appears.

3 When all the files have been deleted, click OK.

Uninstalling the printer driver is complete.

If a message prompts you to restart your computer, click OK.

Note ➤ In Windows 95, Windows 98 or Windows Me, you can start the Uninstaller 
by double-clicking Uninstall in the Canon S520 folder on the desktop.
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Printer Driver Functions (Macintosh)

Printer Driver Functions (Macintosh)

• Description of Print Settings

• BJ Print Monitor

• Canceling a Print Job

• Using the Printer with a Network

• Uninstalling Printer Drivers
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Printer Driver Functions (Macintosh)

Description of Print Settings

• Page Setup Dialog Box

• Printer Utility 
Dialog Box

• Print Dialog Box

• Detailed Setting Dialog 
Box

• Options Dialog Box

• Register Settings 
Dialog Box
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Printer Driver Functions (Macintosh)

Page Setup Dialog Box

The Page Setup dialog box contains settings for the printed page, such as the size of the 
print media used and the image printed. To open the Page Setup dialog box, click Page 
Setup on the File menu in your application program. 

(1) Paper Size
Select the size of the paper for the print job from the drop-down menu. To enter the 
size manually, select Custom 1 to Custom 3, then click Custom. 

(2) Banner Printing
Select this check box when printing on banner paper.

(3) Borderless Printing
The image is printed on the entire paper surface, so that no margins are left on the 
four sides of the paper. The media types available for borderless printing are PR-101 
and GP-301/GP-301N. For all other media types, the print quality may decrease.

(10)

(1)
(2) (7)
(3) (8)

(6)

(4)
(5)

(9)
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Printer Driver Functions (Macintosh)

(4) Amount of Extension
When you select Borderless Printing, the sections that extend beyond the paper are 
not printed because the image is enlarged to a size slightly larger than the paper size. 
You can use the slider to adjust how much the image extends beyond the paper. It is 
recommended that you normally set the slider to the right end. If you move the slider 
to the left to reduce the extension amount, a border may appear.

(5) Scale
Specify the scaling percentage to resize the document for printing.

(6) Orientation
Select landscape or portrait printing. 

(7) Custom
To customize a paper size, click the Custom button to open up the Paper Size 
menu.The Custom dialog box lets you specify the length and width of the paper.

(8) Utilities
Click to open the Printer Utility dialog box for maintenance operations such as 
printhead cleaning, nozzle check pattern printing and changing the print mode. 

(9) Save Settings
Saves the settings specified in the Page Setup dialog box.

(10) Preview Area
Shows how the document will print with the selected paper settings.
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Printer Driver Functions (Macintosh)

Printer Utility Dialog Box

The Printer Utility dialog box is displayed when you click the Utilities button in the Page 
Setup dialog box.

(1) Select the function you wish to perform.

(2) Display area showing the various maintenance functions, including cleaning and test 
pattern printing. Click the icon to start this function. For further details, refer to 
"Routine Maintenance." 

➡ Printing the Nozzle Check Pattern

(1)

(2)
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Printer Driver Functions (Macintosh)

➡ Printhead Cleaning

➡ Printhead Deep Cleaning

Note ➤ For information about printhead alignment, refer to the printed Quick Start 
Guide. 
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Printer Driver Functions (Macintosh)

Print Dialog Box

The Print dialog box specifies the media type and print settings to be used for your print job. 
To open the Print dialog box, click Print on the File menu in your application program. 

(1) Media Type
Ensure that this setting matches the type of media loaded in the printer. 

(2) Grayscale Printing
Select to print a grayscale version of a color document.

(3) Print Mode
Click the icon that most closely resembles your document and required print results.

(1)

(2)

(3)
(4)

(5)

(6)
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Printer Driver Functions (Macintosh)

(4) Details
Manually set the print quality and color settings in the Detailed Setting Dialog Box. 
(This option is only available if Manual print mode is selected.)

(5) Options
Specify the output destination, print order and page layout for the document you are 
printing. 

(6) Apply
Allows you to register print settings or implement a previously saved print setting. 
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Printer Driver Functions (Macintosh)

Detailed Setting Dialog Box

To open the Detailed Setting dialog box, select Manual  in the Print dialog box, then 
click Details.

(1) Panel display icons
Click these icons to switch between panels in the Detailed Setting dialog box.

(1)
(2)

(3)
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Printer Driver Functions (Macintosh)

(2) Print Quality
Move the slider to adjust the balance between print quality and speed. Moving the 
slider to the right enhances print quality, and moving it to the left increases printing 
speed.

(3) Halftoning
Click either Dither or Diffusion ink dot configurations. 
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Printer Driver Functions (Macintosh)

■ Special Effects Panel

To display the Special Effects panel, click the Special effects icon. 

(1) Simulate illustration
This function lets you manipulate color image data to produce illustration effects. 
Select the check box, then adjust the brightness of the image with the Contrast slider.

(5)

(1)

(2)

(3)

(4)
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Printer Driver Functions (Macintosh)

(2) Monochrome effects
Prints a color image in a single color. Select the check box, then choose the color you 
wish to use.

(3) Vivid Photo
With this function, you can reproduce breathtaking sceneries in which colors, 
especially blues and greens, appear even more vibrant. A major feature of this 
function is its ability to create vivid backgrounds for fields, trees, oceans, and sky, 
while maintaining the natural skin tones of people who appear in the images.

(4) Photo Optimizer PRO
Optimizes the color for images taken from a digital camera or scanner. It is especially 
effective for images affected by color imbalance and over- or under-exposure.
When printing several images on one page, optimization is usually applied to each 
image according to its requirements. However, if the image data has been 
manipulated using cut and paste, rotation or other such operations, group optimization 
of all images on the page is recommended. In such cases, select the Apply 
Throughout Page check box. 

(5) Preview Area
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■ Color Panel

To display the Color panel, click the Color display icon. 

(1) Color Correction
Select a color correction method: BJ Standard, ColorSync or None. BJ Standard is 
usually the optimum color correction method for printing with a BJ printer. When 
ColorSync is selected, you should also specify the Print Type and Printer Profile 
settings.

(1)
(2)
(3)
(4)

(5)

(6)
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(2) Print Type
For printing that emphasizes intermediate colors, select Photo. For printing that 
emphasizes the brightness of primary colors, select Graphics. For documents that 
contain large amounts of a basic color, select Spot Color. 

(3) Printer Profile
Select optimized color characteristics (a profile) for the media type and other factors. 

(4) Gamma Correction
This function adjusts the contrast of colors other than black and white. To adjust the 
contrast, select the check box, then move the slider. Moving the slider to the right 
darkens the entire image while increasing contrast in the lighter areas and decreasing 
contrast in the darker areas.

(5) Color Balance
Move the slider for each color to adjust the balance of color intensity. Moving the slider 
to the right intensifies the color.

(6) Intensity
Move the slider to adjust the print density. Moving the slider to the right increases the 
density. 
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Options Dialog Box

To open the Options dialog box, click Options in the Print dialog box.

(1) Layout
Use this function to print more than one page on a single sheet of paper. Typically, this 
is set to 1 Page/Sheet Printing. You can also enlarge printing so that a single page 
spans multiple sheets of paper by using the Poster Printing feature. If you select 
2Page/Sheet Printing or 4Page/Sheet Printing, you should also set Page Order to 
specify the document page order for printing. The Border option allows you to print a 
border around the individual document pages if desired.

(1)

(2)(7)

(4) (5)
(6)

(3)
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(2) Duplex Printing
The document is printed on both sides of the paper. After printing on one side, turn the 
ejected page over and print on the other side.

(3) Fit-to-page Printing
Executes scaled printing automatically. When selected, you can specify the Printer 
Paper Size. This fits the document paper size set in the application to the selected 
paper size.

(4) Destination
Select the print output destination. Printer is the usual selection. To check the layout 
or other image elements before printing, select Preview. To save the document as a 
PICT file, select PICT File.

(5) Print in reverse order
Prints the document starting with the last page. 

(6) Print collated pages
Prints multiple copies of the document one copy at a time. 

(7) Preview Area
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Register Settings Dialog Box

To open the Register Settings dialog box, click Apply in the Print dialog box.

(1) Settings
Displays a list of the registered print settings.

(2) Import
Imports a group of saved print settings. To use the settings, select the desired settings 
in the Settings list, then click Import.

(3) Apply
Saves the settings currently specified in the Print dialog box. After clicking the button, 
enter a name for the settings. 

(4) Remove
Deletes unwanted print settings. Under Settings, select the settings you want to 
delete, then click Remove. 

(5) Defaults
Restores the selected print settings to defaults. A check mark appears next to the 
selected print settings.

(1)

(2)

(3)

(4)

(5)
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BJ Print Monitor

The BJ Print Monitor allows you to check the progress of print jobs. You can launch the BJ 
Print Monitor if background printing is enabled in the Chooser utility.

■ Opening the BJ Print Monitor

1 Click Chooser on the Apple menu.

2 Set Backgrounding to On.

3 After starting a print job, click BJ Print Monitor in the Application menu. 

The BJ Print Monitor launches.
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■ BJ Print Monitor Functions

You can change the print order of documents queued for printing in the BJ Print Monitor. To 
change the print order, place the mouse pointer over the name of the document, hold the 
mouse button down while dragging the document name to the new position, then release. 
You cannot change the print order of a document already printing.

Note ➤ If you click Print on the File menu, you can print the PICT file saved under 
Destination in the Option dialog box.

 ... Click to pause printing of the specified document.

 ... Click to resume printing.

 ... Click to cancel printing of the specified document.

Displays the printer status. If an error occurs, instructions on what to do are 
displayed.
Displays the printer status and ink status with images. 

Displays information about the documents queued for printing. 
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Canceling a Print Job

When the BJ Print Monitor is running, you can use it to cancel or suspend a current job.

1 Click BJ Print Monitor in the Application menu. 

2 Click the name of the print job you want to cancel, then click .

The document selected in the Print Monitor is deleted from the print list and 
the print job is canceled. 

Note ➤ To suspend printing, click the name of the document being printed, then 
click . To resume printing, click .
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Using the Printer with a Network

The printer can be used with an Ethernet network environment. Follow the steps described 
below to connect the printer to the network. 

■ Before Setting up the Printer

• Install the printer driver on each network computer that will use the printer. For 
information on installation, refer to the printed Quick Start Guide.

• Use a USB cable to connect the printer to the computer that will function as the print 
server. 

■ Printer Setup

To use the printer on a network, first set up the print server, then set up each client 
machine.

• Print server setup procedure

1 Click Chooser in the Apple menu.

2 Click Active next to AppleTalk.

3 Select the S520 icon, then select the printer name in Connected to.
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4 Click Share.

5 Confirm that S520 server is selected in Enter new print server name, 
then click Send. 

6 Confirm that the new print server name has been added to Current print 
servers, then click Close.

7 Click the close box to close the Chooser.

• Client setup procedure

1 Click Chooser on the Apple menu.

2 Click Active next to AppleTalk.

3 Select the S520 (Server) icon, then select the printer server in Connected 
to.

4 Click the close box to close the Chooser.
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■ Checking Print Status

• Checking print status from the print server
To check the status of a print job from the print server, start the BJ Print Monitor by 
selecting BJ Print Monitor from the Application menu. To close the BJ Print Monitor, 
click Close Status Window on the File menu.

• Checking print status from a client
To check the status of a print job from a client, start the BJ Status Monitor by clicking 
the BJ Status Monitor icon in the BJ Extras folder. To close the BJ Status Monitor, 
click Quit on the File menu.

• The BJ Print Monitor and BJ Status Monitor
The BJ Print Monitor and the BJ Status Monitor both display a list of information 
concerning documents queued for printing. This information includes the document 
name, number of pages, number of copies and the time when the print job was 
accepted. The total number of queued documents is also displayed. The BJ Print 
Monitor allows you to change the print order of the queued documents.

➡ BJ Print Monitor Functions

➡ BJ Status Monitor Functions
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■ BJ Status Monitor Functions

....Click to pause printing of the specified document. 

....Click to resume printing. 

....Click to cancel printing of the specified document.

Note ➤ • You can determine the owner of a computer by selecting the File Sharing 
control panel and checking the Owner Name item.

• If you are using two or more print servers, you can switch between the BJ 
Status Monitor displays. Click Print Server on the File menu, then select 
the desired print server and click OK.
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Uninstalling Printer Drivers

When a printer driver is no longer needed, use the Installer to delete all the program files 
associated with it at the same time.

Before proceeding, ensure that you save any unsaved files in currently running applications. 

1 Insert the Setup Software & User's Guide CD-ROM, into the CD-ROM 
drive.

2 Double-click the Printer Driver folder.

3 Double-click the Installer icon.

4 When the Software License Agreement is displayed, click Accept. 

5 Select Uninstall from the popup menu, then click Uninstall.

Note ➤ If a warning message appears indicating that other applications are 
running:
• Click Cancel and save the document(s) if there are any unsaved 

documents open in the other applications.
• Click Continue to continue the uninstall operation.

6 After the uninstall is complete, a message appears prompting you to restart 
your computer. Click Restart. 



64

Routine Maintenance

Routine Maintenance

• When to Replace Ink Tank and Maintain Printhead

• Replacing an Ink Tank

• Printing the Nozzle Check Pattern

• Printhead Cleaning

• Printhead Deep Cleaning

• Cleaning the Printer

• Transporting the Printer
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When to Replace Ink Tank and Maintain Printhead

The BJ Status Monitor (Windows) or the BJ Print Monitor (Macintosh) will initially advise 
you of a low ink level. At this stage, you can still continue to print for a limited time.

Once an ink tank is empty, the BJ Status Monitor (Windows) or the BJ Print Monitor 
(Macintosh) will tell you to replace the ink tank. Attempting to print causes the POWER 
lamp to flash four times.

➡ Replacing an Ink Tank

If printing becomes faint or a specific color is no longer printing, even though there is still 
enough ink, the printhead nozzles are probably clogged. Follow the procedures below to 
clean the nozzles.

➡ Printing the Nozzle Check Pattern

If the print quality is poor

➡ Printhead Cleaning

If the problem remains

➡ Printhead Deep Cleaning

If printhead deep cleaning does not resolve the problem, the printhead may be worn out. 
Contact a Customer Care representative.
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Replacing an Ink Tank

When replacing an ink tank, check the model number carefully. The printer will not print 
properly if the wrong ink tank is used, or if it is installed incorrectly.

With this printer, ink tanks must be installed in the order indicated below, starting from the 
right of the printhead.

• Yellow: BCI-3eY
• Magenta: BCI-3eM
• Cyan: BCI-3eC
• Black: BCI-3eBK

Note ➤ Damage caused by using a refilled cartridge is not covered by the Canon 
warranty. Canon recommends using only original Canon ink tanks to 
ensure the best quality.

1 Ensure that the printer is on, then open the front cover.

The printhead holder moves to the center.
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2 Remove the empty ink tank.

Push the tab and remove the ink tank.

Do not touch the lock lever; remove only the ink tank.

Important ➤ • Handle ink tanks carefully to avoid staining clothing or the surrounding 
area.

• Discard empty ink tanks according to the local laws and regulations 
regarding disposal of consumables.
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3 Unpack the new ink tank and pull off the orange tape.
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4 Remove the orange protective cap from the bottom of the ink tank.

Important ➤ • Do not re-attach the protective cap once you have removed it. 
• Once you have removed the protective cap, do not touch the open ink 

port. 

Never press here! 
Ink may squirt out of the tank.
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5 Insert the ink tank into the printhead holder.

Press on the "PUSH" mark until the ink tank snaps firmly into place.

6 Close the front cover.

The printhead holder moves to the right. The ink tank installation process is 
now complete.

Note ➤ • To maintain optimal print quality, use an ink tank within six months of first 
use.

• Once an ink tank has been used, do not remove it from the printer and 
leave it out in the open. Leaving an ink tank in the open will cause ink to dry, 
and the printer may not function properly when the ink tank is reinstalled.
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Printing the Nozzle Check Pattern

Print the nozzle check pattern to determine whether the ink sprays normally from the 
printhead nozzles, and to verify printhead alignment. Use this function when printed results 
are blurred or the color is incorrect.

Nozzle check pattern printing can be executed from the Windows and Macintosh printer 
drivers, or from the printer itself.

■ Printing the Nozzle Check Pattern from the Printer Drivers

Windows

1 With the printer on, load a sheet of letter-size or A4 paper in the printer.

2 Open the Printer Properties dialog box.

➡ Opening the Printer Properties Dialog Box

3 Click the Maintenance tab, then click the Nozzle Check icon.

4 When the confirmation message is displayed, click OK.

➡ Examining the Nozzle Check Pattern
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Macintosh

1 With the printer on, load a sheet plain letter-size paper in the printer.

2 Open the Page Setup dialog box.

The Page Setup dialog box can normally be opened by clicking Page 
Setup on the File menu.

3 Click on Utilities to open the Printer Utilities dialog box.

4 Select Test Print from the drop-down menu, then click the Nozzle Check 
icon.

5 When the confirmation message is displayed, click OK.

➡ Examining the Nozzle Check Pattern
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■ Printing the Nozzle Check Pattern through the Printer

1 With the printer on, load a sheet of letter-size or A4 paper in the printer.

2 Hold the RESUME/CANCEL button down until the POWER lamp flashes 
twice.

➡ Examining the Nozzle Check Pattern
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■ Examining the Nozzle Check Pattern

The nozzle check pattern should appear as follows when ink is discharged properly. 
Examine the nozzle check pattern output by the printer.

Lines missing here indicate the 
printhead requires cleaning.

Unevenness in these patterns 
indicates the printhead requires 
alignment.
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Printhead Cleaning

Clean the printhead if you suspect that the nozzles might be clogged. Printhead cleaning 
can be performed either from the printer drivers or from the printer itself.

Note ➤ Cleaning the printhead consumes ink, so perform printhead cleaning only 
when necessary.

■ Cleaning the Printhead from the Printer Drivers

Windows

1 Ensure that the printer is on.

2 Open the Printer Properties Dialog Box.

➡ Opening the Printer Properties Dialog Box

3 Click the Maintenance tab, then click the Cleaning icon.
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4 Select the ink nozzles to be cleaned, then click Execute.

All Colors: All nozzles
Black: Black ink nozzles
Color: Color ink nozzles

5 When the confirmation message is displayed, click OK.

Macintosh

1 Ensure that the printer is on.

2 Open the Page Setup dialog box.

The Page Setup dialog box can normally be opened by clicking Page 
Setup on the File menu.

3 Click Utilities to open the Printer Utility dialog box.

4 Select Cleaning from the drop-down menu, then click the Cleaning icon.
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5 Select the ink nozzles to be cleaned, then click OK.

All Colors: All nozzles
Black: Black ink nozzles
Color: Color ink nozzles

■ Cleaning the Printhead from the Printer

This operation cleans all nozzles, both black and color. Because this method also resets the 
printer, any print data stored in the printer is lost.

1 Ensure that the printer is on.

2 Hold down the RESUME/CANCEL button until the POWER lamp flashes 
once.

Now the POWER lamp starts flashing and printhead cleaning begins. Do not perform any 
other operations until the printhead cleaning has finished. This takes about 40 seconds.

After printhead cleaning is complete, print the nozzle check pattern to verify that the 
printhead is clean. If not, repeat printhead cleaning. If the printhead is still not clean after 
the third cleaning, perform printhead deep cleaning.

➡ Printing the Nozzle Check Pattern

➡ Printhead Deep Cleaning
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Printhead Deep Cleaning

If print quality does not improve by standard printhead cleaning, try deep cleaning, which is 
a more powerful process. Perform printhead deep cleaning from the printer driver.

Note ➤ Printhead deep cleaning consumes more ink than standard printhead 
cleaning, so perform this procedure only when necessary.

Windows

1 Ensure that the printer is on.

2 Open the Printer Properties dialog box.

➡ Opening the Printer Properties Dialog Box

3 Click the Maintenance tab, then click the Deep Cleaning icon.

4 When the confirmation message is displayed, click OK.
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Macintosh

1 Ensure that the printer is on.

2 Open the Page Setup dialog box.

The Page Setup dialog box can normally be opened by clicking Page 
Setup on the File menu.

3 Click the Utilities button to open the Printer Utility dialog box.

4 Select Cleaning from the drop-down menu, then click the Deep Cleaning 
icon.

5 Click OK.

Now the POWER lamp starts flashing and printhead deep cleaning begins. This process 
can take up to two minutes. The POWER lamp stops flashing when printhead cleaning is 
complete.

After printhead deep cleaning finishes, print the nozzle check pattern to verify that the 
printhead is clean. If not, check that there are sufficient ink levels in all ink tanks before 
turning off the printer. Be sure to perform another printhead deep cleaning 24 hours after 
turning off the printer.If the head is still not clean, the printhead may be worn out. In this 
event, contact the Customer Care Center.

➡ Printing the Nozzle Check Pattern
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Cleaning the Printer

During normal printing, ink and small scraps of paper accumulate in the printer. When the 
accumulated debris becomes clearly visible, clean the printer by the following procedure.

1 Turn the printer off.

2 Ensure that the POWER lamp is off, then unplug the printer.

Caution ➤ Always ensure that you unplug the printer before cleaning the printer to 
avoid an electric shock. 
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3 Open the front cover and wipe the interior of the printer with a dry cloth.

Wipe away any stray drops of ink, scraps of paper, and dust. Pay special 
attention to cleaning the black panel, as it can easily become dirty. While 
cleaning, be careful not to touch the ink absorber (sponge part). Never 
touch any parts inside, such as the metal bar, and so on.

Warning ➤ Do not use any flammable solvents such as paint thinner, benzene or 
alcohol.

Black panel Metal bar Ink absorber
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Transporting the Printer

Pack the printer carefully in its original packing materials.

If you do not have the original packing materials, pack the printer carefully and thoroughly in 
protective material and place it inside a sturdy box.

1 Turn the printer off.

2 Ensure that the POWER lamp is off, then unplug the printer.

Important ➤ To protect the printer from damage, do not unplug the printer while the 
POWER lamp is lit or flashing.
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3 Remove the paper rest and the paper output tray.

4 Disconnect the printer cable from the computer and the printer, then 
disconnect the power cord from the printer.
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5 Secure the printer with adhesive tape as shown, then pack it in a plastic 
bag.
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6 Attach protective material to both sides of the printer when packing the 
printer.

Clearly label the box as "Fragile" if using a transport company.
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• Compatible Media Types

• Envelopes

• High Resolution Paper HR-101N

• Glossy Photo Paper GP-301/GP-301N

• High Gloss Photo Film HG-201

• Glossy Photo Cards FM-101

• Photo Paper Pro PR-101

• Photo Paper Pro PC-101S

• Transparencies CF-102

• T-Shirt Transfers TR-201

• Banner Paper
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Compatible Media Types

You can use the following types of paper and other media.

■ Size

• Standard paper: From Legal size (8.5 x 14.0 in.) to A5 size (5.83 x 8.27 in.)
• Non-standard paper: From 3.54 x 4.72 in. to 8.5 x 23.0 in.
• Others: Envelopes (US Com. #10 and European DL)

Important ➤ Do not use the following types of paper. Using such paper will not only 
produce unsatisfactory results, but can also cause the printer to jam or 
malfunction.
• Folded, curled or wrinkled paper
• Wet paper
• Paper that is too thin (less than 17 lb.)
• Paper that is too thick* (more than 28 lb.)
• Picture postcards
• Postcards with an affixed photo or sticker
• Envelopes with a double flap
• Sealed envelopes
• Envelopes with an embossed or treated surface 
• Paper with holes (such as loose-leaf paper)

* non-Canon branded paper
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■ Weight

17 to 28 lb.
Do not use paper heavier than this (except for supported Canon-brand media), as it 
could jam in the printer.

■ Types

The following types of media can be used. For more information about the media and the 
printing methods, refer to the specific sections.

Plain paper: Refer to the printed Quick Start Guide.

➡ Envelopes

➡ High Resolution Paper HR-101N

➡ Glossy Photo Paper GP-301/GP-301N

➡ High Gloss Photo Film HG-201

➡ Glossy Photo Cards FM-101

➡ Photo Paper Pro PR-101

➡ Photo Paper Pro PC-101S

➡ Transparencies CF-102

➡ T-Shirt Transfers TR-201

➡ Banner Paper
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Envelopes

Use US Com. #10 or European DL size envelopes.

■ Preparation for Printing

1 Press down on all four corners and edges of the envelopes to flatten them 
as shown below.

2 If the envelopes are curled, hold the opposite corners and gently bend 
them in the opposite direction.

Ensure that the flap of the envelope is perfectly straight.
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3 If the leading edge of an envelope is puffed up or curled, use a pen to press 
the envelope flat and sharpen the crease.

The above illustrations show a side view of the leading edge of the 
envelope.

The envelopes may jam in the printer if they are not completely flat and the 
edges are not aligned.

Ensure that no curl or puff exceeds 0.2 in. 

■ Unsuitable Envelopes

• Envelopes with an embossed or treated surface 
• Envelopes with a double flap or pressure seals

Press the envelope completely flat, 
working from the middle to the edge.
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■ Loading

• Place envelopes lengthwise with the flap to the left and the address side facing up.
• Set the paper thickness lever to the right.
• Up to 10 envelopes can be loaded at once.

Note ➤ If the envelopes still do not feed properly even after removing curl, clean 
the paper feed roller.

1 Ensure that the printer is on, and that no paper is loaded in the printer.

2 Hold down the RESUME/CANCEL button. When the POWER lamp 
flashes three times release the RESUME/CANCEL button. The paper 
roller will rotate ten times as it cleans. Repeat this operation three 
times.

Paper 
thickness 
lever
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3 Load a sheet of plain letter-size paper in the printer.

4 Press and hold the RESUME/CANCEL button. After the POWER lamp 
flashes three times to feed the sheet release the RESUME/CANCEL 
button. Repeat this three times.

If the printer still does not feed the envelopes through even after cleaning, 
repeat Step 4 again.

■ Printer Driver Settings

• Media Type: Envelope
• Page Size: Select either #10 Env. or DL Env., according to the envelope size you 

are using.
• Orientation: Landscape

■ Handling of Printed Output

Remove each envelope as it is printed.

■ Printable Area

➡ Printing Area
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High Resolution Paper HR-101N

This type of paper provides better color reproduction than plain paper. It is suitable for 
printing business documents that feature graphics, and for photographs.

■ Loading

• Load the paper with the whiter side facing up.
• Set the paper thickness lever to the left.
• Do not load paper higher than the limit mark. A maximum of 80 sheets can be loaded.

Paper thickness lever

Print side
(whiter side)
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■ Printer Driver Settings

• Media Type: High Resolution Paper
• Page Size: Ensure that the setting matches the size set in the application.

■ Handling of Printed Output

Do not stack more than 50 sheets in the paper output tray. If the output paper is curled, it 
may prevent the next sheet from being ejected. In this case, or if the ink takes a long time 
to dry, remove each sheet as soon as it is printed.

■ Printable Area

With some images, the trailing edge of the image may be blurred if printing extends into 
the printable area. Canon recommends that you print within the printing area.

➡ Printing Area
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Glossy Photo Paper GP-301/GP-301N

This media is still thicker than High Resolution Paper, with a glossy printing surface to 
produce printouts close to photograph quality.

■ Loading

• Load only one sheet at a time.
• Load the paper with the whiter side facing up.
• Set the paper thickness lever to the left.

Paper thickness lever

Print side
(whiter side)

• Do not use the loading support sheet provided with the package.
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■ Printer Driver Settings

• Media Type: Glossy Photo Paper
• Page Size: Ensure that the setting matches the size set in the application.

■ Handling of Printed Output

• Remove each sheet as soon as it is printed.
• Do not touch the printed surface until the ink is fixed (approximately two minutes).

■ Printable Area

With some images, the trailing edge of the image may be blurred if printing extends into 
the printable area. Canon recommends that you print within the printing area.

➡ Printing Area

Note ➤ For photos and illustrations that you want to print with Borderless Printing, 
create the document data by using the same size as the paper size, and 
paste the data so that it fills the editing screen without leaving any margins. 
If you are using an application that allows you to set margins, set the left, 
right, top and bottom margins to 0 in. For instructions on setting margins, 
refer to the application’s user manual.
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High Gloss Photo Film HG-201

This film has an extremely glossy surface, ideal for printing photographs with outstanding 
results.

■ Loading

• Load only one sheet at a time.
• Load the film with the cut corner at the upper right.
• If the film is curled, flatten it by curling in the opposite direction.
• Set the paper thickness lever to the left.

Paper 
thickness 
lever

Cut corner
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■ Printer Driver Settings

• Media Type: High Gloss Photo Film
• Page Size: Ensure that the setting matches the size set in the application.

■ Handling of Printed Output

• Remove each sheet as soon as it is printed.
• Do not touch the printed surface until the ink is fixed.

■ Printable Area

With some images, the trailing edge of the image may be blurred if printing extends into 
the printable area. Canon recommends that you print within the printing area.

➡ Printing Area
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Glossy Photo Cards FM-101

This photo-size paper is intended for printing images that cover the entire surface of the 
card, without a white border. When printing, use the original application software, 
ZoomBrowser EX/PhotoRecord (for Windows) or ImageBrowser (for Macintosh).

■ Loading

• Load the paper with the glossy side facing up.
• Set the paper thickness lever to the left.
• A maximum of 20 sheets can be loaded at once.
• Do not use the loading support sheet provided with the package.

Paper 
thickness 
lever

Print side
(glossy side)



Glossy Photo Cards FM-101 100

Printing Media

■ Handling of Printed Output

• Do not stack more than 20 sheets in the paper output tray.
• Do not touch the printed surface until the ink is fixed (approximately. two minutes).
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Photo Paper Pro PR-101

This is thick paper with a treated surface that enhances gloss and provides superior color 
reproduction. It is ideal for printing high quality photographs. This media is available in 
Letter/A4 and 4" x 6" sizes.

■ Loading

• You can load one sheet of letter-size or A4 paper at a time, and up to 20 sheets of 4" x 
6" size paper. 

• Load the paper with the glossier side facing up.
• Set the paper thickness lever to the left.

Paper thickness lever

Print side
(glossier side)
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Printing Media

■ Printer Driver Settings

• Media Type: Photo Paper Pro
• Page Size: Ensure that the setting matches the size set in the application.

■ Handling of Printed Output

• Remove each sheet as soon as it is printed. 
• Do not stack more than 20 sheets of 4" x 6" size paper in the output tray. 
• Do not touch the printed surface until the ink is fixed (approximately 30 minutes). Colors 

in dark images may appear indistinct at first, but become clearer after about 30 
minutes.

• Images may smudge if you place them in an album before the ink is completely dry. It is 
recommended that you allow the ink to dry for 24 hours.

• Do not attempt to dry the ink with a hairdryer or by exposing printed sheets to direct 
sunlight.

■ Storing Printed Output

• Do not store or display printouts in hot, damp or humid conditions. Never expose them 
to heat or direct sunlight.

• Store printouts in photo albums, photo frames or presentation binders to protect them 
from direct exposure to air or sunlight.

• Do not mount printouts in an adhesive-type album, as you may not be able to remove 
them.

• Be aware that some types of clear plastic folders and albums may cause the edges of 
the paper to turn yellow.
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Printing Media

■ Printable Area

With some images, the trailing edge of the image may be blurred if printing extends into 
the printable area. Canon recommends that you print within the printing area.

➡ Printing Area

Note ➤ For photos and illustrations that you want to print with Borderless Printing, 
create the data by using the same size as the paper size, and paste the 
data so that it fills the editing screen without leaving any margins. If you are 
using an application that allows you to set margins, set the left, right, top 
and bottom margins to 0 in. For instructions on setting margins, refer to the 
application’s user manual.
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Printing Media

Photo Paper Pro PC-101S

Made of the same material as Photo Paper Pro PR-101, this photo-size paper is intended 
for printing images that cover the entire surface of the card, without a white border. When 
printing, use the original application software, ZoomBrowser EX/PhotoRecord (for 
Windows) or ImageBrowser (for Macintosh).

■ Loading

• Load the paper with the glossy side facing up.
• Set the paper thickness lever to the left.
• A maximum of 20 sheets can be loaded at once.

Paper 
thickness 
lever

Glossy side
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Printing Media

■ Handling of Printed Output

Follow the instructions described in "Photo Paper Pro PR-101".
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Printing Media

Transparencies CF-102

This film is ideal for printing presentation material for use with overhead projectors.

■ Loading

• Place one sheet of letter-size or A4 paper under the transparencies in the sheet feeder.
• Set the paper thickness lever to the left.
• A maximum of 30 sheets can be loaded at once.

Paper thickness lever

Plain paper

Transparencies
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Printing Media

• Although you can print on either side of CF-102, best results can be obtained by 
printing on the side toward which it curls when held by the edge.

■ Printer Driver Settings

• Media Type: Transparency
• Page Size: Ensure that the setting matches the size set in the application.

■ Handling of Printed Output

• Remove each transparency as soon as it is printed.
• Do not touch the printed surface until the ink is fixed (approximately 15 minutes).

■ Printable Area

➡ Printing Area

Print side
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Printing Media

T-Shirt Transfers TR-201

This paper is used to produce iron-on transfers. The image is printed backward (mirror 
image) when Media Type is set to T-Shirt Transfer in the printer driver.

Note ➤ For more information refer to the instructions packaged with your media.

■ Loading

• Load only one sheet at a time.
• If the T-shirt transfer is curled, flatten it by curling it in the opposite direction.
• Load the paper with the side that does not have green lines facing up.
• Set the paper thickness lever to the right.

Paper thickness lever
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Printing Media

■ Printer Driver Settings

• Media Type: T-Shirt Transfer
• Page Size: Ensure that the setting matches the size set in the application.

■ Handling of Printed Output

• Remove each T-shirt transfer as soon as it is printed.
• The T-shirt transfer should be used as soon as it is printed. Refer to the supplied 

instructions for details on how to use this media.

■ Printable Area

➡ Printing Area
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Printing Media

Banner Paper

This is long paper that consists of consecutive sheets of letter-size or A4 paper, ideal for 
printing long posters or banners (up to six sheets long).

■ Preparation for Printing

• When tearing the banner paper, tear off one more sheet than you actually need to print.
• The maximum length for one print job is six sheets, so if you will be printing on six 

sheets, tear off a seven-sheet length.

■ Loading

1 Set the paper thickness lever to the right.

2 Load the banner paper with the printing side facing up. Gently fold the 
perforation between the first and second sheets.

Leave the rest of the paper folded up.
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Printing Media

3 Place the printer where the printed banner output can hang over the edge 
of the table.

Ensure that the ink does not stain the table or floor.
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Printing Media

■ Printer Driver Settings

• Media Type: Plain Paper
• Page Size: Letter or A4
• Copies: Must be set to "1" to print correctly. 
• In Windows, select Banner Printing for Printing Type on the Page Setup tab.
• In Macintosh, before creating the document, select Banner Printing in the Page Setup 

dialog box.

■ Printable Area

➡ Printing Area
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Troubleshooting

Troubleshooting

• Cannot Install the Printer Driver

• Print Quality is Poor or Contains Errors

• Printer Does Not Start or Stops During Print Jobs

• Paper Does Not Feed Properly or Paper Jams

• The POWER Lamp Flashes Orange

• An Error Message is Displayed on the Screen

• Problems Unique to Windows 

• Problems Unique to the Macintosh 

Windows

Macintosh



Cannot Install the Printer Driver 114

Troubleshooting

Cannot Install the Printer Driver

■ Follow the installation procedure correctly.

Install the printer driver carefully following the procedures described in the printed Quick 
Start Guide.

If the printer driver was not installed correctly, reinstall it. If you are using Windows, 
delete the printer driver before reinstalling it.

➡ Uninstalling Printer Drivers

Note ➤ If the Installer was forcibly terminated due to an error in Windows, Windows 
may be unstable. This could prevent the printer driver from being installed. 
Restart the computer before reinstalling the printer driver.

■ Close any other applications before installation.

Sometimes the printer driver cannot be installed because another application is running.
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Troubleshooting

■ If the Installer for the printer driver does not start automatically 
when you insert the Setup Software & User’s Guide CD-ROM, open 
the My Computer window, then double-click the CD-ROM icon. 

Note ➤ If you are typing in the file name, you must specify the CD-ROM drive letter 
and the installation program ("msetup.exe"). The CD-ROM drive letter is 
different on different computers.

■ Confirm that there are no problems with the Setup Software & User’s Guide 
CD-ROM.

In Windows, use Windows Explorer to ensure that the CD-ROM can be read. In a 
Macintosh, check that the CD-ROM icon is visible. If there is a problem with the 
CD-ROM, contact the Customer Care Center.

Windows
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Troubleshooting

Print Quality is Poor or Contains Errors

• Cannot Print to End of Job

• Colors are Unclear

• Meaningless Characters or Symbols are Printed

• Printing is Blurred/Colors are Wrong

• Straight Lines are Misaligned

• Printed Paper Curls or Ink Blots

• Back of Paper is Smudged

• Printed Surface is Scratched

• White Streaks

• Colors are Uneven or Streaked
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Troubleshooting

Cannot Print to End of Job

■ Confirm that the Page Size setting matches the size of the paper loaded in the 
printer.

First, check the Page Size setting in the application.

Next, check the Page Size setting in the Printer Properties dialog box for Windows or the 
Page Setup dialog box for Macintosh.

Note ➤ When using an ECP printer port in Windows, you may not be able to print 
due to the computer environment. For details, refer to "Problems Unique to 
Windows".

■ Check the amount of the space on the hard disk.

You may need to increase the amount of free space by deleting any unnecessary files.
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Troubleshooting

Colors are Unclear

■ Confirm that the Media Type setting in the printer driver matches the type of paper 
loaded in the printer.

If you are printing a photograph or an illustration from Windows, also increase Print 
Quality on the Main tab.

If you are working in a Macintosh, click the Photo or Graphic icon for the Print Mode 
in the Print dialog box.

■ Confirm that the specified ink tank is installed.

When an ink tank runs out of ink, replace it with a new one.

Note ➤ Printed colors may not match screen colors perfectly due to basic 
differences in the methods used to produce colors. Color control settings 
and environmental differences can also affect how colors appear on the 
screen.
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Troubleshooting

Meaningless Characters or Symbols are Printed

■ If the problem only occurs when printing a specific document, try editing the 
document, then printing it.

If this does not resolve the problem, there may be a problem with your application 
program. 
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Troubleshooting

Printing is Blurred/Colors are Wrong

■ If a specific color does not print, check whether the corresponding ink tank is 
empty. Replace if necessary.

■ Print the nozzle check pattern to ensure that ink is output correctly.

If the nozzle check pattern does not print correctly, clean the printhead.

➡ Printing the Nozzle Check Pattern

➡ Printhead Cleaning

If the problem is not resolved after cleaning the printhead several times, the printhead 
may be worn out. Contact a Customer Care representative.

Note ➤ Always ensure that you dispose of the protective cap and protective tape 
from a printhead.

■ Ensure that you are printing on the correct side of the media.

You can only print on one side of certain media. 
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Troubleshooting

Straight Lines are Misaligned

■ Align the printhead.

Ensure that you align the printhead every time you install a new printhead.

Windows

1 Open the Printer Properties dialog box.

2 Click the Maintenance tab.

3 Click Printhead Alignment.

Follow the instructions on the screen.
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Troubleshooting

Macintosh

1 Open the Page Setup dialog box.

2 Click Utilities.

3 Select Test Print from the drop-down menu, then click Printhead 
Alignment.

Follow the instructions on the screen.
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Troubleshooting

■ In the printer driver settings, select a higher print quality setting.

Windows

1 Open the Printer Properties dialog box.

2 On the Main tab, click High for the Print Quality setting.

Macintosh

1 Open the Print dialog box.

2 For Print Mode, select Manual, then click Details.

3 Click the Quality icon, then drag the Print Quality slider to the Fine end.



Print Quality is Poor or Contains Errors 124

Troubleshooting

Printed Paper Curls or Ink Blots

■ Use high resolution paper or photo paper to print images that require a lot of ink 
(for example, photos or pictures with intense colors).

■ Reduce the Intensity setting in the printer driver, then try printing again.

Windows

1 Open the Printer Properties dialog box.

2 On the Main tab, select Manual for Color Adjustment, then click Set.

3 Drag the Intensity slider to adjust the intensity.
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Troubleshooting

Macintosh

1 Open the Print dialog box.

2 For Print Mode, select Manual, then click Details.

3 Click the Color icon, then drag the Intensity slider to set the intensity.
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Troubleshooting

Back of Paper is Smudged

■ If the next page prints before the ink is dry, enable the Pause Page printer driver 
setting.

You can either remove each printed sheet from the output tray as soon as it is printed, 
or enable Pause Page to pause after each sheet has printed.

Windows

1 Open the Printer Properties dialog box.

2 Click the Maintenance tab.

3 Click Custom Settings to open the Custom Setting dialog box.

4 Select Pause Page, then click Send.
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Troubleshooting

Macintosh

1 Open the Page Setup dialog box.

2 Click the Utilities button.

3 Select Custom Settings from the drop-down menu.

4 Select Pause between pages, then click Send.

■ You may need to clean some internal parts of the printer. Follow the procedure 
below.

1 Load several sheets of letter-size or A4 paper into the printer’s paper 
feeder.

2 Hold down the RESUME/CANCEL button until the POWER lamp flashes 
three times, then release the button.

3 Repeat this operation until there are no more smudges on the test page.
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Troubleshooting

Printed Surface is Scratched

■ Ensure that you are using suitable paper.

• The paper weight must be less than 28 lb.

If you use non-Canon brand paper heavier than 28 lb., the printhead may scratch the 
printed surface. Clean the printhead first and print with the correct paper.

• The paper must not be curled.

This problem can be resolved by turning the paper over.

■ Before starting Borderless Printing, check the paper that you are using.

With Borderless Printing, the print quality may decrease or smudging may occur at the 
top and bottom edges of the paper. Use Photo Paper Pro or Glossy Photo Paper. If 
smudging still occurs, set the paper thickness lever to the right and try printing again.

■ When printing on thick paper, set the paper thickness lever to the " " mark.

This widens a gap between the printhead and the paper. If the paper gets scratched 
when printing on plain paper, also try this.
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Troubleshooting

■ Reduce the Intensity setting in the printer driver, then try printing again.

When printing an image with high intensity, especially on plain paper, the paper may 
absorb too much ink and become wavy. This may cause the printed surface to become 
scratched.
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Troubleshooting

Windows

1 Open the Printer Properties dialog box.

2 On the Main tab, select Manual for Color Adjustment, then click Set.

3 Drag the Intensity slider to adjust the intensity.

Macintosh

1 Open the Print dialog box.

2 For Print Mode, select Manual, then click Details.

3 Click the Color icon and drag the Intensity slider to set the intensity.

■ Ensure that you are printing within the recommended printing area.

➡  Printing Area
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Troubleshooting

White Streaks

■ Print the nozzle check pattern to check the ink output.

If a specific color does not print in the nozzle check pattern, clean the printhead.

➡ Printing the Nozzle Check Pattern

➡ Printhead Cleaning

The problem can also be resolved by aligning the printhead. For details on printhead 
alignment, refer to "Straight Lines are Misaligned."
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Troubleshooting

Colors are Uneven or Streaked

■ Increase the print quality setting in the printer driver settings.

Windows

1 Open the Printer Properties dialog box.

2 On the Main tab, click High for the Print Quality setting.

Macintosh

1 Open the Print dialog box.

2 For Print Mode, select Manual, then click Details.

3 Click the Quality icon, then drag the Print Quality slider to the Fine end.
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Troubleshooting

■ Set the halftoning method to Diffusion in the printer driver settings.

Windows

1 Open the Printer Properties dialog box.

2 On the Main tab, select Custom for the Print Quality setting, then click 
Set.

3 Click Diffusion for the Halftoning setting.

Macintosh

1 Open the Print dialog box.

2 For Print Mode, select Manual, then click Details.

3 Click the Quality icon, then click Diffusion for the Halftoning setting.
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Troubleshooting

Printer Does Not Start or Stops During Print Jobs

• Printing Does Not Start

• Printing Stops Before It Is Completed

• Printer Moves But Does Not Print

• Printhead Holder Does Not Move to the Center
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Troubleshooting

Printing Does Not Start

■ Ensure that the printer is turned on.

If the POWER lamp is off, press the POWER button. If the POWER lamp is flashing 
green, the printer is initializing. Wait until the POWER lamp stops flashing.

Note ➤ When printing a large amount of data, such as a photograph or illustration, 
the printer may take longer than usual to begin printing. While the POWER 
lamp is flashing, the computer is processing the data and sending it to the 
printer. Wait until the green lamp stops flashing and printing begins.

■ Ensure that the printer is securely connected to the computer.

Note ➤ If you are using a switch box or other device, remove it and reconnect the 
printer directly to the computer. Try printing again.

If printing is now successful, there may be a problem with the device. Also 
there could be a problem with the cable(s). Replace the cable(s) and try 
printing again.
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Troubleshooting

■ Ensure that the correct printer driver is selected.

In Windows, ensure that Canon S520 is selected in the Print dialog box.
In Macintosh, ensure that S520 is selected in the Chooser.

Note ➤ In Windows, you can set the Canon S520 as the default printer.

■ Ensure that the printer port is set correctly. 

If using a parallel interface printer cable, set LPT1 as the printer port. If using a USB 
cable, set USBPRNnn or USBnnn ("n" represents a number) as the printer port.

1 Open the Printer Properties dialog box from the Start menu.

➡ Opening the Printer Properties dialog box directly from the Start 

menu

2 Click the Details tab (or Ports tab) and set the printer port.

Windows
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Troubleshooting

Printing Stops Before It Is Completed

■ Check the status of the POWER lamp.

When the POWER lamp is flashing green, the printer is processing data. Printing a large 
amount of data such as a photo or graphics takes time for the computer to process the 
data, during which the printer may appear to not be functioning.

In addition, when continuously printing material that uses a large amount of black ink on 
plain paper, the printer will sometimes pause. In either case, wait until the processing is 
completed.

■ Halt the print job, then turn the printer off for at least 15 minutes to cool the 
printhead.

The printhead can overheat when continuously printing for long time. To protect the 
printhead, the printer will sometimes pause automatically at a line break before 
resuming. In this event, interrupt the print job at a convenient time and turn the printer off 
for at least 15 minutes.

Furthermore, when continuously printing graphics or photos with intense colors, printing 
may stop to protect the printhead. In this case, printing will not resume. Turn the printer 
off and wait at least 15 minutes before turning the printer back on and reprinting the job.

Caution ➤ Inside the printer, the area around the printhead can become extremely 
hot. Do not touch the printhead or nearby components.
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Troubleshooting

Printer Moves But Does Not Print

■ Check the ink tanks. If empty, replace them.

■ Ensure that the ink tanks snap into place when you install them.

■ If there is plenty of ink but the printer does not print, then clean the printhead.

After cleaning the printhead, print the nozzle check pattern to check that ink is being 
output normally.

➡ Printhead Cleaning

➡ Printing the Nozzle Check Pattern

If the problem is not resolved by cleaning the printhead several times, the printhead may 
be worn out. Contact a Customer Care Representative.

■ Check that the protective tape has been removed from the printhead.

Ensure that you align the printhead after removing the tape and reinstalling the 
printhead. For details on printhead alignment, refer to "Straight Lines are Misaligned."
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Troubleshooting

Printhead Holder Does Not Move to the Center

■ Ensure that the printer is turned on.

The printhead holder will not move unless the power is on. If the POWER lamp is off, 
close the front cover and turn the power on.

If the POWER lamp is flashing green, the printer is initializing. When the POWER lamp 
stops flashing, open the front cover again.

■ If the front cover has been left open for a while, close and reopen it.

If the front cover is left open for more than 10 minutes, the printhead holder moves to the 
right to prevent the printhead from drying out. Close and reopen the front cover to return 
the holder to the center.
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Troubleshooting

Paper Does Not Feed Properly or Paper Jams

• Paper Does Not Feed Properly

• Paper Jams
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Troubleshooting

Paper Does Not Feed Properly

■ Confirm the paper conditions.

• If using non-Canon brand media, ensure the paper is not too thick (less than 28 lb.).

• Ensure the number of sheets loaded does not exceed the recommended level.

• Ensure the paper is not creased, curled or wrinkled.

➡ Compatible Media Types

■ Ensure that the left edge of the paper touches the paper guide.

■ When printing envelopes, refer to "Envelopes" in "Printing Media," and prepare the 
envelopes before printing.

Once you have prepared the envelopes, load them in the printer in portrait orientation. If 
the envelopes are placed in landscape orientation, they may not feed properly.

■ When using transparencies, load one sheet of plain paper in the printer first, then 
place the transparencies on top of it.

The last transparency may not feed properly unless there is a sheet of plain paper 
beneath it.
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Troubleshooting

Paper Jams

Remove the paper according to the following procedure.

1 Slowly pull the paper out, either from the sheet feeder or from the paper 
output slot, whichever is easier.

If the paper tears and a piece remains inside the printer, open the front 
cover and remove it. 

If you cannot pull the paper out, press the POWER button twice to eject the 
paper automatically.

2 After removing all paper, close the front cover.

3 Reload the paper into the printer, then press the RESUME/CANCEL 
button.

Note ➤ When reloading the paper into the printer, refer to "Paper Does Not Feed 
Properly" to confirm that you are using the correct paper and are loading it 
into the printer correctly.
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Troubleshooting

The POWER Lamp Flashes Orange

An error has occurred in the printer. The number of orange flashes between green flashes 
indicates the type of error, as outlined below. Check the cause and take the appropriate 
action.

■ Two flashes: Out of paper, paper jam or paper feed error

Replace the paper correctly and press the RESUME/CANCEL button. If paper has 
jammed in the printer, clear the jam and press the RESUME/CANCEL button.

■ Three flashes: Paper jam

If paper has jammed in the printer, clear the jam, replace the paper in the printer correctly 
and press the RESUME/CANCEL button.

➡ Paper Jams

■ Four flashes: Empty ink tank

One of the ink tanks is empty. Replace it.

➡ Replacing an Ink Tank
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Troubleshooting

■ Six flashes: No printhead installed

Install a printhead. 

■ Seven flashes: Defective printhead

Contact the Customer Care Center.

■ Eight flashes: Waste ink tank almost full

The printer has a built-in waste ink tank for the ink used during printhead cleaning. Eight 
flashes indicates that the waste ink tank is nearly full. Press the RESUME/CANCEL 
button to cancel the error so you can continue printing. Before the waste ink tank 
becomes completely full, contact the Customer Care Center to have the waste ink tank 
replaced.

Note ➤ Canon recommends that you call the Customer Care Center for service as 
soon as this error occurs. Once the waste ink tank becomes completely full, 
printing will be no longer possible.



The POWER Lamp Flashes Orange 145

Troubleshooting

■ POWER lamp flashes alternate green and orange: 
An error has occurred that may require you to contact the Customer Care Center.

Turn the printer off and unplug the printer from the power supply. Plug the printer back in 
and turn the printer back on. If the problem remains, contact the Customer Care Center.
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Troubleshooting

An Error Message is Displayed on the Screen

• Error Writing to LPT1 or USBxxx 

• Application Error or General Protection Fault 

• Other Error Messages 

• Other Error Messages 

Windows

Windows

Windows

Macintosh
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Troubleshooting

Error Writing to LPT1 or USBxxx 

■ Ensure that the printer is turned on.

If the POWER lamp is off, turn the printer on. If the POWER lamp is flashing green, the 
printer is initializing. Wait until the POWER lamp stops flashing.

■ Ensure that the printer is securely connected to the computer.

Note ➤ If you are using a switch box or other device, remove and reconnect the 
printer directly to the computer and try printing again.

If printing is now successful, there may be a problem with the device. Also, 
there could be a problem with the cable(s). Replace the cable(s) and try 
printing again.

■ If spooling is enabled, disable it to send the print data directly to the printer, then 
try printing again.

1 Open the Printer Properties dialog box from the Start menu.

➡ Opening the Printer Properties dialog box directly from the Start 

menu

Windows



An Error Message is Displayed on the Screen 148

Troubleshooting

2 On the Details tab, click Spool Settings, then select Print directly to 
printer.
In Windows XP, Windows 2000 or Windows NT 4.0, click the Advanced tab 
or Scheduling tab, then click Print directly to the printer.

■ Verify the printer port status.

• When using the parallel interface (in Windows Me/Windows 2000/Windows 98/
Windows 95)
Refer to the Windows NT 4.0 manual for information on operating Windows NT 4.0.

1 Right-click My Computer and select Properties.

2 Click the Device Manager tab.
In Windows 2000, click the Hardware tab, then click Device Manager....

3 Double-click Ports (COM/LPT), then double-click Printer Port (LPT1)*.

* The printer port name depends on your system environment.

4 On the General tab, check for any indication of a problem with the port, and 
whether the connected device is available.
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Troubleshooting

5 Click the Resources tab, then check the Conflicting device list. An error 
is generated if there are any device conflicts. If necessary, delete any 
conflicting devices. For details on how to delete a device, refer to the 
instruction manual for that device.

• When using the USB interface (in Windows XP/Windows Me/Windows 2000/Windows 
98)

1 Right-click My Computer and select Properties.

2 On the Device Manager tab, double-click Universal serial bus controller, 
then double-click Canon S520.

If you are using Windows XP or Windows 2000, click Device Manager on 
the Hardware tab, double-click Universal serial bus controllers, then 
double-click USB Print Support.

3 On the General tab, check for any indication of a problem with the device.

If an error has occurred, reinstall the printer driver according to "Notes on 
Handling the USB Interface (for Windows Users)" in the printed Quick Start 
Guide.
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Troubleshooting

■ Ensure that the printer port setting corresponds to the printer interface 
connection.

Open the Printer Properties dialog box from the Start menu, then click the Details tab 
(or Ports tab). If LPT1:(ECP Printer Port) is displayed in the Print to the following port 
field, the parallel port is selected. If USBPRNnn (Canon S520) or USBnnn (Canon 
S520) ("n" represents a number) is displayed, the USB port is selected.

➡ Opening the Printer Properties dialog box directly from the Start 

menu

If the setting is incorrect, shut down Windows, turn off the printer and either connect the 
printer to the interface selected in the printer driver, or install the correct printer driver 
corresponding to the interface.

■ There may be a problem in the printer driver. Uninstall the printer driver and 
reinstall it.

➡ Uninstalling Printer Drivers

If the printer is connected to the USB interface, follow the procedure “Notes on Handling 
the USB Interface (for Windows Users)” in the printed Quick Start Guide.
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Troubleshooting

■ If the WPS driver or CAPT driver is installed, either uninstall it or change the driver 
port to FILE as follows.

1 Click the Start button, then click Settings, then Printers.

2 Display the WPS or CAPT driver properties, then click the Details tab.

3 Change Print to the following port to FILE.
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Troubleshooting

Application Error or General Protection Fault

■ Ensure that the application program you are using is intended for your operating 
system.

For example, if you attempt to print with a Windows 3.1 application under Windows 98, 
the application may not function correctly and an error may occur. Use an application 
program intended for your operating system.

■ If other applications are running, close them to increase available memory, then 
try printing again.

■ Ensure that enough memory is allocated to the application.

Refer to the memory requirements of your application.

Windows
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Troubleshooting

■ Check the amount of free space on the hard disk.

You may need to increase the amount of free space by deleting any unnecessary files.

■ If the problem only occurs when printing a specific document, try editing the 
document, then printing it.

If this resolves the problem, there may have been a problem in the original document. If 
the same problem occurs with the edited document, contact the manufacturer of your 
application.

■ There may be a problem in the printer driver. Uninstall the printer driver and 
reinstall it.

If the printer is connected to the USB interface, follow the procedure “Notes on Handling 
the USB Interface (for Windows Users)” in the printed Quick Start Guide.

➡ Uninstalling Printer Drivers
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Troubleshooting

Other Error Messages 

■ If the BJ Status Monitor is displayed, follow the instructions on screen.

If an error occurs during printing, the BJ Status Monitor displays the error on the Printer 
Status tab. Follow the instructions on screen.

In Windows 95, Windows 98 or Windows Me, click the Guide tab for the action to be 
taken in response to the error.

Windows
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Troubleshooting

■ If one of the following messages is displayed outside of the BJ Status Monitor:

Could not spool successfully due to insufficient disk space
Increase the amount of free space on the disk by deleting any unnecessary files.

Could not spool successfully due to insufficient memory
Increase available memory by closing any other applications currently running.

Printer driver could not be found
Uninstall the printer driver and reinstall it.

➡ Uninstalling Printer Drivers

Background printing failed (Windows 95/Windows 98/Windows Me only)
Restart Windows and try printing again.

Could not print [Application Name – File Name]
Try printing again once the current job is finished.
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Troubleshooting

Other Error Messages 

■ If a message with the format "Error No.: Xn" (where "X" represents a letter and "n" 
represents a number) is displayed:

Error No.: X202
Not enough memory for printing. Increase available memory by closing any other 
applications currently running.

Error No.: X203
There is a problem with the printer driver. Uninstall the printer driver and reinstall it.

➡ Uninstalling Printer Drivers
Error No.: X300
Ensure that the power is on, and that the printer and the computer are securely 
connected. If the problem remains, verify the Chooser setting.

1 In the Apple menu, click Chooser.

2 Click the S520 icon and ensure S520 is selected as the connected 
destination.

If the problem remains, delete all unnecessary documents from the Extensions and 
Control Panels folder.

Macintosh
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Troubleshooting

Problems Unique to Windows

• The BJ Status Monitor is Not Displayed

• Cannot Print in Background (Windows 95/Windows 98/Windows Me only)

• Cannot Print Normally

Windows
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Troubleshooting

The BJ Status Monitor is Not Displayed

■ Ensure that "Enable bi-directional support for this printer" is selected.

1 Open the Printer Properties dialog box from the Start menu.

➡ Opening the Printer Properties dialog box directly from the Start 

menu

2 On the Details tab (or Ports tab), click Spool Settings and select Enable 
bi-directional support for this printer.

■ If the printer is connected to the parallel interface, ensure that the printer cable 
supports bi-directional communication.

The BJ Status Monitor is displayed only when the computer and cable support bi-
directional communication. If you do not know whether your computer and printer cable 
support bi-directional communication, contact your dealer or computer manufacturer.
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Troubleshooting

Cannot Print in Background (Windows 95/Windows 98/
Windows Me only)

■ Check the amount of free space on the hard disk.

Background printing requires a certain amount of disk space. You may need to delete 
unnecessary files, or disable background printing.

■ Ensure that background printing is enabled.

1 Open the Printer Properties dialog box.

➡ Opening the Printer Properties Dialog Box

2 On the Page Setup tab, click Printer control, then select Background 
Printing.
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Troubleshooting

Cannot Print Normally

■ When the printer port is set to "ECP", cancel ECP mode, then try printing again.

Sometimes ECP mode disrupts normal printing.

1 Open the Printer Properties dialog box.

2 Click the Maintenance tab.

3 Click Custom Settings to open the Custom Setting dialog box.

4 Clear the Set printer to ECP mode check box, then click Send.

5 Turn the printer off and back on again.
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Troubleshooting

■ If the WPS driver or CAPT driver is installed, either uninstall it or change the driver 
port to FILE as follows.

The WPS (Windows Printing System) driver or CAPT (Canon Advanced Printing 
Technology) driver may disrupt normal printing.

1 Click Start, then click Settings, then Printers.

For Windows XP, click Start, then select Control Panel, Printers and 
Other Hardware, then Printers and Faxes.

2 Display the WPS or CAPT driver properties, then click the Details tab.

3 Change Print to the following port to FILE.
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Troubleshooting

Problems Unique to the Macintosh 

• Jagged Text/Graphics or Banded Gradations

• Cannot Print in Background

Macintosh
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Troubleshooting

Jagged Text/Graphics or Banded Gradations

■ Ensure that your application supports Quick Draw.

If you are using a PostScript-compatible application, printed text and lines may appear 
jagged and gradations may appear banded. As S520 is not a PostScript printer but a 
Quick Draw printer, use an application compatible with Quick Draw for printing.
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Troubleshooting

Cannot Print in Background

■ Ensure that background printing is enabled.

1 In the Apple menu, click Chooser.

2 Set Backgrounding to On.

■ Check the amount of free space on the hard disk.

Background printing requires a certain amount of disk space. You may need to remove 
unnecessary files, or disable background printing.
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Appendix

Appendix

• For Faster Printing MacintoshWindows



For Faster Printing 166

Appendix

For Faster Printing 

The USB interface provides the quickest printing with Windows 98, Windows Me and 
Windows 2000. Refer to the printed Quick Start Guide for USB connection details.

When using the parallel printer interface, use the ECP data transfer mode for faster printing.

Note ➤ The ECP mode may not speed up printing on some computers.

1 To enable the ECP mode, first confirm the following:
• The printer and computer are connected with a parallel printer cable.
• The printer driver has been installed.
• The printer port of the computer supports the ECP mode.
• The parallel port is set to ECP mode in the BIOS settings.

Note ➤ Refer to your computer manual for details on printer port specifications and 
BIOS settings.

2 Open the Printer Properties dialog box from the Start menu.

➡ Opening the Printer Properties dialog box directly from the Start 

menu

Windows
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3 Click the Maintenance tab, then click the Custom Settings icon.

4 Select the Set printer to ECP mode check box, then click Send.
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Note ➤ • Some computers may have problems printing in the ECP mode. In this 
case, clear the Set printer to ECP mode check box in the screen above, 
then click Send. Turn the printer off and back on to cancel the ECP mode.

• With Windows 95, a problem may remain after you cancel the ECP mode 
setting. See also “Unable to Print from the Canon BJ Printer Port” in the 
on-line help.
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Specifications

Specifications

Printing method:
Bubble Jet on-demand

Printing resolution:
2400 (horizontal) × 1200 (vertical) dpi max.

Print speed (printing with Canon standard pattern):
Black printing Fast: 14 ppm

Standard: 12 ppm 
Color printing Fast: 9 ppm

Standard: 6 ppm

Print direction:
Bi-directional

Print width:
8.0 in.
(for borderless printing: 8.5 in)

Resident print control mode:
Canon extended mode
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Specifications

Receive buffer:
56 KB

Interface (parallel):
IEEE 1284-compatible

Interface (USB):
USB 1.10-compatible 

Interface connector (parallel):
Amphenol 57-40360 or equivalent

Interface connector (USB):
USB standard Series B receptacle (USB interface)

Recommended printer cable (parallel):
Material: AWG28 or larger
Type: Twisted-pair shielded cable
Length: 6.5 ft.
Connectors: Amphenol 30360 or equivalent

Recommended printer cable (USB):
Material: AWG28 (data wiring pair) or AWG20 to 28 (distribution pair)
Type: Twisted-pair shielded cable
Length: 16.4 ft.
Connectors: USB standard Series B pluggable
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Specifications

Acoustic noise level:
Approximately 42 dB (A) (in the best quality mode)

Operating environment:
Temperature: 41 to 95°F (5 to 35°C)
Humidity: 10 to 90%RH (no condensation)

Storage environment:
Temperature: 32 to 104°F (0 to 40°C)
Humidity: 5 to 90% RH (no condensation)

Power supply:
USA/Canada AC 120 V, 60 Hz
Europe AC 230 V±10%, 50 Hz
Australia AC 240 V, 50 Hz

Power consumption:
Standby: 3 W 
Printing: 33 W

Dimensions (without a paper rest and paper output tray):
16.9 (W) × 11.6 (D) × 7.0 (H) in.

Weight:
Approximately 11 lb.
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Specifications

■ Feed method:

Continuous feed through auto sheet feeder
For plain paper, envelopes, High Resolution Paper, Glossy Photo Paper, 
High Gloss Photo Film, Glossy Photo Cards, Photo Paper Pro, Photo Paper 
Pro for Borderless Printing 4" x 6", Transparencies, T-shirt Transfers, 
Banner Paper

■ Sheet feeder capacity maximum:

Plain paper (75 gsm) 100 sheets 
High Resolution Paper 80 sheets
Envelopes 10 pieces
Glossy Photo Paper 1 sheet
High Gloss Photo Film 1 sheet
Glossy Photo Cards 20 sheets
Photo Paper Pro PR-101 4" × 6": 20 sheets 

A4: 1 sheet
Photo Paper Pro PC-101S 20 sheets 
Transparencies 30 sheets 
T-Shirt Transfers 1 sheet
Banner Paper 1 sheet
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Specifications

■ Ordinary print media:

Regular size: Letter, Legal, A4, A5, B5, European DL, US Com.#10

Custom size: width: 3.54 to 8.5 in.
height: 4.72 to 23.0 in.

Weight: 17 to 28 lb. for non-Canon brand media

Canon Specialty media:
High Resolution Paper HR-101N
Glossy Photo Paper GP-301/GP-301N
High Gloss Photo Film HG-201
Glossy Photo Cards FM-101
Photo Paper Pro PR-101
Photo Paper Pro PC-101S
Transparencies CF-102
T-Shirt Transfers TR-201
Banner Paper
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■ Graphic image printing:

Data format: Canon extended mode: Raster image format

Resolution: Canon extended mode: 300, 600, 1200, 2400 dpi

■ Printhead:

Black: 320 nozzles (600 dpi)

Cyan, Magenta, Yellow: 256 nozzles (1200 dpi)

■ Ink Tanks:

Capacity (pages):
Black (BCI-3eBK) approx. 6951, approx. 12502

Cyan (BCI-3eC) approx. 4602

Magenta (BCI-3eM) approx. 3952

Yellow (BCI-3eY) approx. 3002

1 1500 characters per page, normal text, at standard and plain paper mode with Windows 98 and 
Windows Me

2 Based on printing the ISO JIS-SCID No.5 pattern at standard and plain paper mode with Windows 
98 and Windows Me
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Specifications

■ Printer driver operating environment:

IBM PC/AT-compatible computer running on Windows Me, Windows 2000, 
Windows 98, Windows NT 4.0, Windows 95 or Macintosh computers with USB 
interface running on Macintosh 8.6 to 9.x

■ Hard disk space:

Approximately 15 MB to install on Windows Me, Windows 98 and Windows 95, 30 
MB on Macintosh, or approximately 25 MB on Windows XP, Windows 2000 and 
Windows NT 4.0 (including temporary files). 

Note ➤ When connecting printer and computer through USB interface, use the 
system under the following operating environment.

Windows Computer with Microsoft Windows XP, Windows 2000, Windows Me or 
Windows 98, which is preinstalled by a computer manufacturer on 
purchase. (USB port operation also needs to be assured by the 
manufacturer.)

Macintosh Macintosh computers with USB and Macintosh 8.6 to 9.x, which is 
preinstalled by a computer manufacturer on purchase. 

Specifications subject to change without prior notice.



176

Specifications

■ Printing Area

To ensure the best print quality, the printer allows a margin along each edge of 
media. 

Printing area (dark blue): Canon recommends that you print within this area.  
( )

Printable area (light blue): The area where it is possible to print. However, printing in 
this area may degrade the print quality and paper feed 
accuracy, or cause ink to adhere to the printing surface.  
( )

➡ 4" x 6", A4, B5, A5,

➡ Letter, Legal

➡ Envelopes

➡ Banner Paper
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Specifications

4" x 6", A4, B5, A5, 

Note ➤ When printing on PR-101 and GP-301/GP-301N, selecting Borderless 
Printing enables you to make prints with no margins. However, Borderless 
printing may cause the top and bottom edges of paper to decrease in print 
quality or become soiled.

Size Printable Area (width x height)

4" × 6" 3.7 × 5.7 in.

A4 8.0 × 11.4 in.

B5 6.9 × 9.8 in.

A5 5.6 × 7.9 in.

1.3 in.

1.04 in.

0.13 in. 0.13 in.

0.2 in.

0.12 in.

Recommended printing area

Printable area
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Specifications

Letter, Legal

Note ➤ When printing on PR-101 and GP-301/GP-301N, selecting Borderless 
Printing enables you to make prints with no margins. However, Borderless 
printing may cause the top and bottom edges of paper to decrease in print 
quality or become soiled.

Size Printable Area (width x height)

Letter 8.0 × 10.7 in.

Legal 8.0 × 13.7 in.

1.3 in.

1.04 in.

0.25 in. 0.25 in.

0.2 in.

0.12 in.

Recommended printing area

Printable area
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Specifications

Envelopes

Size Printable Area (width x height)

European DL 7.5 × 4.1 in.

US Com. #10 8.3 × 3.9 in.

0.12 in 1.04 in

0.13 in.

0.13 in.

Printable area
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Specifications

Banner Paper

Size Printable Area (width x height)

Banner Paper Letter: 8.0 × 65.7 in

0.13 in.

0.13 in.

0.12 in.
1.1 in. 0.2 in.

Max. 6 sheets
Min. 2 sheets

Recommended printing area

Printable area
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A
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B
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Index

Chooser (Macintosh) 56
Cleaning 32, 43, 75
Cleaning the Printer 80
Client (Macintosh) 60
Compatible Media Types 87

D
Deep Cleaning 32, 78
Duplex Printing 25, 54

E
ECP mode 166
Envelopes 89
Error Message 146, 154, 156

F
Fit-to-page Printing 24, 54
Front cover 13, 139

G
Gamma Correction (Macintosh) 52
General Protection Fault 152
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H
High Gloss Photo Film HG-201 97
High Resolution Paper HR-101N 93
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I
Ink Tank 65, 66

M
Media Type (Macintosh) 45
Media Type (Windows) 21

N
Network (Macintosh) 59
Nozzle Check Pattern 74

O
Opening the Printer Properties Dialog Box (Windows) 18

P
Page Setup Dialog Box (Macintosh) 41
Page Size (Windows) 23
Paper feed roller 91
Paper Guide 13
Paper Jams 142
Paper Output Tray 13
Paper Rest 13
Paper Size (Macintosh) 41
Paper Thickness Lever 15
Photo Optimizer PRO (Macintosh) 50
Photo Optimizer PRO (Windows) 29
Photo Paper Pro PC-101S 104
Photo Paper Pro PR-101 101
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Poster Printing 24, 53
POWER Button 16
POWER Lamp 16, 143
Print Advisor (Windows) 22
Print Dialog Box (Macintosh) 45
Print Mode (Macintosh) 45
Print server (Macintosh) 59
Printable area 176
Printer Driver (Macintosh) 39
Printer Driver (Windows) 17
Printer port 148, 150
Printer Port (Parallel) 14
Printer Properties Dialog Box (Windows) 18, 20
Printhead Holder 15
Printhead Lock Lever 15
Printing Area 176
Printing the Nozzle Check Pattern 71

R
Replacing an Ink Tank 66
RESUME/CANCEL Button 16

S
Sheet Feeder 13
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W
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